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Getting Started 
 

Introduction  

 
Scoop Edit is the complete radio news preparation and delivery system 
designed for stations of all types and sizes. When coupled with Scoop 
Capture, Scoop Edit provides a scaleable solution for the capture, processing, 
compilation and delivery of news bulletins as well as offering the ability to 
publish news bulletins to your stations web site. 
 
Scoop Edits key features are: 
 

· Real time updated list of incoming stories from all sources.  
· Powerful search facilities to allow you to find the story you need.  
· Stories containing key words are highlighted to bring them to your 

attention.  
· Stories are categorised for your convenience.  
· Displays incoming emails (including attachments) from a standard 

POP3 email server.  
· Displays incoming faxes from a compatible fax server (such as MS Fax 

Server).  
· Edit existing stories and add new stories at the touch of a button.  
· Powerful text editing tools including spell checking facilities.  
· Create 'web' versions of your stories for publishing to the Internet.  
· Browse and record audio with the Audio Wall and quick record 

facilities.  
· Import audio directly from hard disk based audio devices (such as USB 

hard disks etc).  
· Built in audio editor (SmoothEdit) for fast, efficient audio editing.  
· Assign multiple audio cuts to a single text story.  
· Complete contacts management system built in to the system.  
· Integrated web browsing so you never need to leave Scoop.  
· Compile bulletins for 'live reads' and publishing to the web.  
· Live news scripts are displayed on screen with the audio cuts 

automatically cued when you need them.  
· Control the entire live bulletin with just two buttons on the keyboard.  
· Publish your bulletins to your stations web site with no knowledge of 

how to build a web page (just hit publish and Scoop does the rest).  
· Scoop allows a small newsroom to get big newsroom results without 

working the journalists to death!  

 

Scoop Edit General Screen Layout  
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Once Scoop Edit is installed and configured to work with Scoop Capture, you 
are ready to start working with Scoop to view and edit captured stories, add 
your own content and create final bulletins to deliver ‘live on air’ and to your 
stations web site. 
 
The main Scoop Edit window is divided in to four main areas as shows below. 
 
 

 
 
 
 
Each of these areas offers a number of tools and options which will be 
covered in more detail later in full User Guide but in brief, each area performs 
the following roles. 
 

Tool Bar  & Menus  
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The Tool Bar and Menu section of the Scoop Window provides a whole host 
of tools and options for using and configuring Scoop. 
 
The Tool Bar and Menu system general layout is outlined below. 
 
 

 
 
 
 

New Element 

 
This allows you to add a new element to Scoop. The button is context 
sensitive so it will open a new version of whatever element you are working 
on. If for example, you are currently working with SmoothEdit then clicking on 
this button will open a new audio cut. 
 
You can also use the drop down list to select the type of new element you 
want Scoop to open. 
 

 
 
 

Print 

 



 9 

The Print button will send the currently highlighted document to the printer. To 
select the printer that you want to use, click on the Print Setup option on the 
File menu. 
 
 

Display Main Tab Panel 

 
This button toggles the Main Tab panel between being visible and hidden. 
You may wish to hide the Main Tab Panel when you are working on a story 
and need more space in the Main Workspace area, or when you are using the 
Bulletin window to deliver a ‘live’ bulletin. 
 

  
 
 

Open Bulletin Window 

 
 
This button toggles the Bulletin window between being visible and hidden. 
The Bulletin window is used to prepare bulletins for both live reading and 
publishing to a web site. It is also used to deliver live bulletins using the built 
in Playout mode. 
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Display Audio Browser 

 
 
This button opens the Audio Browser which is a tool that is used to browse 
and search the Audio Wall that Scoop is using to store audio cuts. 
 
For more details on the Audio Browser, see the Audio Tab section of this 
document. 
 

 
 
 
 

Display Cart Pad 

 
This button opens a Pad window which can be used to play several audio 
Carts ‘back to back’ or even compile them in to a single Cart. The Pad is 
covered in more detail in the Main User Guide. 
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Latest Story Ticker 

 
The Latest Story Ticker shows a list of the most recently captured Stories so 
that you are always up to date. The list only shows Stories that have not been 
viewed yet and is updated automatically as new Stories arrive. It also shows 
incoming emails and faxes (if your system is configured to include these). 
 
You can click on the Stories in the Latest Stories Ticker to open them in the 
Main Workspace area. 
 
If you minimise Scoop Edit to work with another windows application, the 
Latest Stories Ticker remains on screen to alert you to the latest captured 
Stories. 
 

 
 
 

The Menu System 

 
The Menu system is used to provide alternative access to Scoop’s tools and 
facilities, as well as to configure Scoop and customise it to your needs. The 
Menu system is covered in depth in the Main documentation but is outlined 
below. 
 

The File Menu 

 
The File menu provides primary access to the Scoop file options and allows 
you to change the Scoop Database that you are working with. 
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The options are outlined below: 
 

· New – This menu option allows you to create a new Scoop Element. 
Use the pop out menu to select the type of new Element you wish to 
create. 

· Print Setup – This allows you to set and configure the printer that 
Scoop will use. 

· Change Scoop Database – This allows you to close the current Scoop 
Database and select an alternative database. You can also copy and 
manage your Scoop Database using the Options menu on the Select 
Database window that this option opens. 

 

 
 

· Recent Stories – Shows a list of recent Stories. 
· Recent Audio – Shows a list of recent Audio Carts. 
· Recent Contacts – Shows a list of recent Contacts. 
· Recent Web – Shows a list of recent Stories. 
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· Exit – Closes Scoop. 
 
 

The View Menu 

 
The View menu allows you to view various parts of Scoop. 
 
 

 
 
 
The options are: 
 

· Display Bulletin – Opens the Bulletin window. 
· Cart / Audio Browser – Opens the Audio Browser window. 
· Cut Pad – Opens the Pad window. 
· Run Cart Report – Opens the Cart Report window which allows you to 

extract several information reports on the Carts on your Audio Wall. 
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To use this too, tick the options or criteria that you wish to use for the 
Cart Report and then click on the OK button. 
 
The results are displayed in the Cart Report window. 
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The Cart Report window provides a number of powerful tools via the 
tool bar at the top of the window. You can select multiple Carts in the 
main part of the window and then click on the tools on the tool bar. 
Hover over each tool to see what it does. 
 

· Refresh – Reloads the information in the Main Tab Panel. 
 
 

The Tools Menu 

 
The Tools menu provides access to a range of tools in Scoop. 
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The options are outlined below: 
 

· Customise Scoop – The Customise Scoop option opens the Customise 
Scoop window which allows you to alter a range of settings and options 
on a per User basis. Options changed in the Customise Scoop window 
are only applied to the User logged in at the time. 

 

 
 
For full details on these options, please refer to the full Scoop 
documentation. 

 
· Change Password – This allows you to change the Password of the 

currently logged in User. 
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· Database Tools – This pop out menu offers a range of database 
related tools. 

o Import A Scoop v2 Database – Imports an older Scoop v2 
stories database. 

o Create A Backup Of The Current Database – Creates a backup 
of the currently open Scoop database. 

o Check The Database Structure Is Valid – Checks the currently 
open database for problems or incompatibility. 

o Compact / Repair The Current Database – This option will 
compact the currently open database and repair any problems 
that it encounters. 

o Compact / Repair Any Database – This option performs the 
same Compact / Repair operation as the previous option but it 
allows you to select the database that you want to perform the 
repair on. 

 
 

The Settings Menu 

 
The Settings menu provides access to the Scoop Settings options. 
 

 
 
 
These options will be configured when the system is installed and 
should not be altered unless directed to by a P Squared support 
engineer. 
 
The options are: 
 

· Audio Setup – This allows you to setup and alter the audio related 
Scoop features including the setup of Cart Players and recording 
options.  

· Audio File Locations – This option is used to set the location of the 
audio files used by Scoop. This is more commonly known as the Audio 
Wall. 
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· Scoop Database Settings – This offers a large range of Scoop options 
and settings that relate to the Scoop Database. These will apply on a 
system level basis, so changes made in this section will effect all 
Scoop workstations accessing the Database. 

 

 
 
 

· P Squared Directory Settings – The P Squared Directory is a 
centralised directory of Scoop Users. It is used to manage the security 
groups that Scoop Users belong to, which in turn controls the level of 
access the User has to the system. 
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· Scoop Program Settings – This allows you to set options that relate to 
the current workstation only (regardless of who is logged in). This 
allows you to vary settings for workstations in different roles. 

 

 
 
 
You also use this to set the location that Scoop uses to store the Scoop 
Database. 

 
· License Code – This option is used to access the P Squared License 

wizard which is used to enter and update the periodic License Codes 
issued by P Squared.  
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The Windows Menu 

 
The Windows menu offers a range of options relating to the different windows 
that are contained within Scoop. These are usually Element windows such as 
Story or Audio Cart windows that are open within the Main Scoop Workspace. 
 
 

 
 
 
The options are outlined below: 
 

· Cascade – The windows are ‘cascaded’ over the Main Workspace 
Area. 

· Tile Side By Side – The windows are arranged side by side across the 
Main Workspace Area. 

· Tile Full Width – The windows are arranged one above the other 
across the Main Workspace Area. 

· Arrange Icons – This option arranges the icons for minimised Elements 
along the bottom of the Main Workspace Area tidying it up. 

· Close All Stories – This option closes all open Story Elements. Any 
Stories that have not been saved will be flagged up before they are 
closed to offer you the chance to save them. 

 
 

The Help Menu 

 
The Help Menu offers access to the help and support features in Scoop. 
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· Create P2 Support File – This is a very useful feature that automatically 
gathers together information about your Scoop system and sends it to 
P Squared for analysis. You may be asked to create a Support File by 
a P Squared engineer as part of the support diagnosis process. If so, 
then click on the option and fill in the P Squared Support ID number 
that the engineer gives you. 

 
 

 
 
 

Follow the support engineers guidance to fill in the additional fields and 
then click on the Make File button. The Support File will be created and 
automatically sent to the P Squared support team. 

 
· Update Information – Clicking this option will display the latest Update 

Information file which lists the version history for the product. Check 
this file to see the latest additions and fixes to the system directly after 
you have upgraded to a new version. 

· P Squared On The Web – This pop out menu option allows you to visit 
some of the P Squared web sites. 
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· Help – This accesses the Scoop help system. 
· About Scoop – Displays version information about the currently 

installed version of Scoop. You should know what version of Scoop you 
are using before you contact P Squared for support. 

 

 
 

 

The Main Workspace Area  

 
 
The Main Workspace Area is the area of the central screen that is used to 
display and work on the elements that make up Scoop edit. These include: 
 
§ Text Stories 
§ Audio Carts 
§ Contact Details 
§ Web Pages 
§ Emails 
§ Faxes 
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§ Bulletins 
§ Web Previews 

 
The Main Workspace area is used to display all of these elements. 
 

 
 
 
You can open multiple elements in the Main Workspace at the same time. In 
the example above, there are several Stories open as well as an audio Cart, a 
Contact Detail and a Web page. 
 
Each of these open elements is represented on the Switch Bar that runs along 
the bottom of the Main Workspace area. 
 

 
 
 
You can switch between these elements by clicking on them on the Switch 
Bar. 
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The Main Tab Panel  

 
The Main Tab Panel is used to display, manage and access all of the Stories, 
audio Carts, Contacts and Web pages that are available from Scoop. The 
Main Tab panel is divided in to four tabs to represent the different types of 
element that are available. These tabs are: 
 
§ Stories – Displays all text stores (both captured and manually typed), 

emails and faxes. 
§ Audio – Displays all of the audio Carts that are available. 
§ Directory – Shows Contact Details for both Scoop users and useful 

contacts for the newsroom. 
§ Web – Shows useful web pages that can be accessed directly from 

within Scoop. 
 
To access the different elements using the Main Tab Panel, click on the 
corresponding tab. 
 
 

The Stories Tab 

 
 
The Stories Tab shows all of the text Stories that are stored on the system. 
These include Stories captured from one or more ‘news wire’ services (such 
as IRN Net Newsroom or Sky News) as well as Stories that have been 
manually added by journalists. 
 
It also includes emails that have been captured from a POP3 email server and 
if you have it configured, from a fax server as well. 
 
The Stories tab allows you to view the Stories by Category as well as when 
they arrived. You can also use Find facility to search for Stories that contain 
key words or phrases. 
 

The Stories Tab Layout 

 
The Stories tab layout is outlined below. 
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The layout is explained in more detail below. 
 

Find Criteria 

 
The Find Criteria field allows you to type in a word or phrase that you want to 
search the Stories on Scoop for. Once the search is completed, the Stories 
tab will only display Stories that contain the word or phrase that you have 
searched for. 
 
You can use the drop down list to view and reuse Find Criteria that you have 
used recently. 
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Once you have typed in the Find Criteria, click on the Start Search button to 
begin the search (or press <Enter> on the keyboard with the Find field in 
focus). 
 
To return to listing all Stories in the Stories Tab, select <All Stories> from the 
Find drop down list, or perform a search with the Find field empty. 
 

Start Search Button 

 
Click on the Start Search button to begin the search process (see above). 
 
 

Audio Cut Number 

 
This field is automatically provided by some ‘wire feed’ news services and 
usually refers to the accompanying audio cut for the Story. It can also be 
manually entered on to Stories using the Stories tab when the Story is open. 
 
 

Story Title 

 
This displays the Stories title as provided by the ‘wire feed’ service or the 
Story author. You can alter a Stories title by opening it and typing in a new 
title in to the Title field. 
 
Stories that have not been viewed will be indicated by the Title appearing in 
bold in the Stories list. 
 
Stories that contain one or more of the Key Words that Scoop Capture is 
searching incoming Stories for will appear with the Title in red text. 
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Also, Stories that of a non standard Priority (see Information tab on the actual 
Story window) will have a coloured background to the Title section to indicate 
the Priority of the Story. 
 
 

Attached Cart 

 
The Attached Cart field shows the Cart number of an Audio Cart that is 
attached to the Story, or if more than one Cart is attached to the Story 
then it indicates the amount of Carts attached. If the field is blank then it 
indicates that the Story currently does not have a Cart attached. 
 
The Attached Cart field is also used to show if the Cart that is attached 
is in the Scoop Capture range of Carts and so is not a ‘safe’ Cart. If the 
Cart attached to a Story is in the Scoop Capture range then there is a 
chance that Scoop Capture could erase it to replace it with another 
Captured Cart, so the Cart should be moved to a safer area on the 
Audio Wall as soon as possible. This is indicated by the background to 
the Attached Cart Field being yellow. 
 
If you open a Story in this state (by double clicking on it), you will be 
asked if you wish Scoop to move the Cart for you. 
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Time Restriction Tabs 

 
These customisable tabs allow you to restrict the Stories listed to within a set 
time frame. The default for this is: 
 
§ Last 24 Hours – Only display Stories added in last 24 hours. 
§ Last 48 Hours – Only display Stories added in last 48 hours. 
§ All Stories – Display all Stories regardless of when they were added. 

 
These descriptions and time frames can be customised to your needs. 
 
The reason for this feature is that as time goes by, your entire Scoop 
database is likely to get very large and displaying all the Stories would be 
slow, and would be largely irrelevant most of the time. This feature allows you 
to decide the time frames that are most important to your newsroom, and 
allows you to concentrate on only the current stories whilst still giving access 
to all Stories should you need it. 
 
You can switch between these three time frames by clicking on the 
appropriate tab. 
 
N.B. When switching to All Stories, it is normal for Scoop to take several 
seconds to compile the list of Stories. 
 

Story Preview 

 
This provides a preview of the highlighted Story text to allow you to read 
through and ensure it is the Story you are after before you open it. 
 
 

Current Time 

 
This clock shows the current time, but it also turns red 5 minutes from the top 
of the hour to indicate that a bulletin may be due soon. 
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Last Captured Cart 

 
This indicates the location of the last audio Cart captured by Scoop Capture. If 
the Cart has not been auditioned then it will flash to indicate that it is new. 
Click on the Cart to open it using SmoothEdit. 
 
 

The Audio Tab 

 
The Audio Tab is used to browse and access the audio Carts that Scoop 
uses. Carts are stored on the Audio Wall which is a list of numerically ordered 
Carts of up to 100,000. The Audio Wall can be configured to be ‘stand alone’ 
for Scoop use only, or if you also have Myriad or AutoTrack Pro then the 
Audio Wall can be shared between products to provide greater flexibility and 
integration. 
 
The Audio Tab is used to browse the Audio Wall, but it is also used to allow 
you to edit Carts using SmoothEdit (double click on them) and assign them to 
Stories by dragging Carts from the Audio Wall directly on the Audio tab for the 
Story. 
 
 

The Audio Tab Layout 

 
The Audio Tab layout is outlined below. 
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These options are outlined below. 
 
 

Select Cart 

 
The Select Cart button opens the highlighted Cart using SmoothEdit to allow 
you to edit the Audio or Cart details. 
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Play Cart 

 
The Play Cart button will play the highlighted Cart using one of the free Cart 
Players located at the bottom of the Scoop Edit screen. 
 
 

Home Area 

 
Clicking on this button will jump the highlighted Cart to the Home area of the 
currently logged on User. You can also use the drop down option on this 
button to access additional Home Area options. 
 

 
 
These options are: 
 
§ Personal Edit Area – Jump to the beginning of the personal area of the 

logged on User. 
§ Last Created Cart – Jump to the last Cart created or recorded on the 

system. 
§ Last Capture Cart – Jump to the last Cart captured by Scoop Capture. 
§ Next Empty – Jump to the next empty Cart on from the currently 

highlighted Cart. 
 

Show Empty Carts 

 
This option toggles the Audio Tab to display Carts slots that are currently 
empty. If this option is turned off then the Audio tab will only display Carts that 
contain audio. 
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Move Cart 

 
This option will move the highlighted Cart to another position on the Audio 
Wall. To use this option, click on the Move button and then type in the 
Destination Cart that you want to move it to. Then click on OK 
 

 
 
 

Copy Cart 

 
The Copy Cart option allows you to copy the contents of a Cart to another 
Cart slot on the Audio Wall. To use this feature, click on the Copy button and 
type in the Destination Cart that you want to copy the Cart to, then click on 
OK. 
 

 
 
 

Edit Cart 

 
Clicking on this button will open the highlighted Cart in SmoothEdit to allow 
you to edit the audio or Cart Details. 
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Delete Cart 

 
The Delete Cart option allows you to delete the highlighted Cart removing it 
completely from the system (and Audio Wall). 
 
CAUTION – Once a Cart has been deleted there is no way to recover it.  
 
You will need appropriate access rights to use this feature. 
 
 

Find Criteria 

 
You can use this facility to search for Carts on the Audio Wall that contain a 
specific word or phrase in the Title, Artist or Description fields and optionally in 
the Notes and Copyright fields. 
 
To use this facility, type in the word or phrase you wish to search for and then 
either click on the Start Search button (see below) or press the <Enter> key 
on the keyboard. 
 
Once the search is complete, the Audio Browser will only display Carts that 
contain the specified word or phrase. 
 
 

Start / Stop Buttons 

 
The Start button is used to start a search based on the Find Criteria (see 
above). Once started, the Stop button becomes enabled which allows you to 
stop the search mid way through. Any Carts that have been already found will 
remain visible in the Audio tab. 
 

Search Notes 

 
This option can be toggled on and off, and allows you to specify whether 
Scoop should also check Cart Notes when searching for Carts that contain 
the Find Criteria. When this button is depressed, Scoop will search the Cart 
Notes as well as the standard Cart Description fields. 
 
 

Copyright Notes 

 
This option can be toggled on and off, and allows you to specify whether 
Scoop should also check the Copyright details when searching for Carts that 
contain the Find Criteria. When this button is depressed, Scoop will search 
the Copyright details as well as the standard Cart Description fields. 
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Jump To Cart 

 
This field allows you to type in a specific Cart number to jump the highlighted 
Cart to. Once you have typed in the Cart number you wish to jump to, click on 
the Jump button or press the <Enter> key on the keyboard. 
 
 

Jump Button 

 
This button is used in conjunction with the Jump To Cart field to allow you to 
jump the highlighted Cart to a specific Cart slot on the Audio Wall. 
 
 

Page Up / Down Buttons 

 
These buttons scroll up or down the Audio Wall a page at a time. You can do 
the same thing with the <Page Up> and <Page Down> buttons on the 
keyboard. 
 

Cart Number 

 
Shows the Cart Number for the Cart on the Audio Wall. 
 
 

Cart Title 

 
This field displays the Title and (if possible) the Artist for the Cart on the Audio 
Wall. 
 
 

Cart Duration 

 
This field shows the duration of the Cart on the Audio Wall. If the Cart has an 
Extro set then this will be the length of time from the beginning of the audio 
file to the Extro point. If no Extro is set then this will be the overall length of 
the audio file. 
 
 

Edit Cart 

 
Clicking on this button will open the Cart in SmoothEdit to allow you to edit the 
audio or the Cart Details. 
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Play Cart 

 
The Play Cart button will load the Cart into one of the free Cart Players at the 
bottom of the screen. 
 
 

The Directory Tab 

 
The Directory tab is used to view, edit and manage the P Squared Directory 
database, which is a contact database that allows you to keep track of 
peoples contact details and where appropriate, their access to the Scoop 
system. 
 
The Directory database can be used to store contact details for Scoop Users, 
but also for any other people or organisations that your journalists will find 
useful. This means that as well as the staff contact details, it might also 
include the local police and council contacts and the late night take away 
shop. 
 

The Directory Tab Layout 

 
The Directory tab layout is outlined below. 
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Find Criteria 

 
You can search the contacts listed in your Directory using the Find Criteria 
field. Type in the name or word that you want to look for in to the Find field 
and then click on the Start Search button or press the <Enter> key. 
 
You can use the Find drop down list to view and select recently used Find 
Criteria. 
 
 

Start Search 

 
Used in conjunction with the Find Criteria, the Start Search button is used to 
start a search of the Directory for the specific name or word. 
 
 

Contacts Categories 

 
In order to help you navigate the Contacts Directory, it can be organised in to 
Contacts Categories. Contacts can be added to specific Categories and the 
Contacts Categories ‘tree view’ can be used to navigate through these 
categories. 
 
To add a new Contacts Category or manage existing Categories, use the right 
click menu. 
 

 
 
 
The options are: 
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§ Open Category – Opens the selected Category. 
§ New – Allows you to add a new Contact or a new Category. 
§ Delete Category – Deletes the highlighted Category. 
§ Rename – Renames the highlighted Category. 

 

Contact Details 

 
The Contact Details section shows a list of all of the Contacts that are in the 
selected Category or meet the Find Criteria (or both).  
 
To open the Contact Details for a Contact just double click on it in this list. 
 
You can also right click in this area to access the right click menu. 
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This offers a range of options to allow you to manage and export contact 
details. 
 
You can also drag Contacts from the Contact Details area in to the Contact 
Categories folders (directly above) in order to move Contacts around in 
different Contact Categories, 

Shared / Personal Contact Tabs 

 



 42 

Scoop allows you to specify whether a Contact is Shared (available to all 
Users on all Scoop workstations) or Personal (only available to the person 
logged in). The Shared / Personal tabs allow you to select whether you wish 
to view Shared Contacts or Personal Contacts. 
 
 

The Web Tab 

 
The Web Tab provides access to Scoops web browser, and also an enhanced 
web site listing system that is a little like the favourites section of Internet 
Explorer but can be more customised to your needs. 
 
The idea behind the inclusion of the web browser in Scoop is that you can 
research stories and drag text from a web page directly in to a Story without 
ever leaving Scoop. 
 
 

 
 
 

The Web Tab Layout 

 
The Web Tab layout is outlined below. 
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These features are explained in more detail below. 
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Find Criteria 

 
As with all the other tabs we have looked at, you can search the list of web 
sites on the Web tab for a web site that has a word or phrase in the title or 
address. 
 
To use this facility, type in the word or phrase that you are looking for in the 
Find field and click on the Start Search button or press the <Enter> key. 
 
You can use the drop down list to view and select Find Criteria you have used 
recently. 
 
Once the search is completed, the results are displayed in the Web Site 
Details section of the tab. 
 

Start Search 

 
Used in conjunction with the Find Criteria, the Start Search button initiates the 
search of the listed web sites looking for one or more that match the criteria. 
 
 

Web Site Categories 

 
Just as with the Contacts we looked at in the last section, Scoop allows you to 
organise the web sites that you have listed in to categories to make viewing 
and managing them simpler. 
 
The Categories are organised in to a ‘tree’ structure, with navigation working 
by way of clicking on folders to expand the list of web sites in that Category. 
 
You can drag Web sites from the Web Site Details (lower) section in to the 
Category Folders to move Web sites from one Category to another.  
 
You can add and manage Web Site Categories using the right click menu. 
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The right click options are: 
 
§ Open Category – Opens the selected Category. 
§ New – Allows you to add a new Contact or a new Category. 
§ Delete Category – Deletes the highlighted Category. 
§ Rename – Renames the highlighted Category. 

 
 

Web Site Details 

 
This section lists all of the Web Sites that are in the selected Category or 
meet the Find Criteria (or both). You can open a Web Site by double clicking 
on it. You can also move a Web Site in to a different Category by dragging it 
from the Details section in to the desired Web Category Folder in the upper 
‘tree view’ section. 
 
There is also a right click menu in the Web Site Details section to allow you to 
add, edit and manage your Web Sites. 
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When you add a new Web Site to the system, you are asked for some simple 
information about the site. Fill in this information and the site will be added. 
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Shared / Personal Web Sites 

 
When you add a new Web Site to the system, you set whether or not the Web 
Site is to be added as a Personal Web Site. If you add a Site as a Personal 
site, it will only be available to you. Other Users will not be able to see it listed. 
If not then the Web Site will be visible to all Users on all workstations. 
 
You can use the Personal / Shared tab to switch between viewing the Shared 
Web Sites and your Personal Web Sites. 
 
 

New Browser 

 
Clicking the New Browser button will open the Scoop Web Browser which will 
allow you to ‘surf’ the web. 
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The Cart Players  

 
The Cart Players are used by Scoop to play all audio that is not played 
directly in the SmoothEdit window. The amount of Cart Players that you have 
configured will depend on the type of sound card that you use and the role 
that the Scoop workstation plays, it is recommended that all Scoop 
workstations are configured to have at least two Cart Players. 
 
 

The Cart Players Layout 

 
The Cart Players are common to Myriad, Scoop and AutoTrack Pro although 
the look may differ slightly between products. The general Cart Player layout 
is outlined below. 
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The top section of the Cart Players panel contains the Record Cart Player 
which is used to manually record incoming audio in to Scoop. 
 
The bottom section is dedicated to the Cart Players which are used to play 
audio Carts out from Scoop. 
 
Each section is covered in more detail below. 
 
 

Start / Stop Recording Buttons 

 
These two buttons are used to Start and Stop Recording respectively. When 
you click on the Record button (the circle), Scoop automatically finds the next 
free Cart in your User Edit Range, and then allows you to type in a name for 
the Cart you are about to record. 
 

 
 
 
When you are happy, click on OK. 
 
Depending on how your Scoop is configured, you may be asked whether you 
wish to use ‘trigger level’ recording, which means that Scoop will not start 
recording until audio is detected. 
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If you click on Yes then Scoop will not start recording until audio is detected, if 
you click on No then Scoop will start recording immediately. 
 
When you are ready to stop recording click on the Stop button (the square). 
You will then be asked whether you wish to save the recorded audio. 
 

 
 
Click on Yes if you wish to save it and No if you wish to discard it. 
 
 

Record Cart Number 

 
This indicates the Cart Number that the Record Cart Player is currently 
recording in to. 
 
 

Record Cart Title 

 
This displays the Title for the Cart that is currently being recorded. You can 
edit this field even while the Cart is being recorded. 
 
 

Time Recorded 

 
This indicates the total time recorded so far. 
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Time Remaining 

 
This indicates the record time remaining available to the system, but it only 
operates when there is less than three hours available so unless this number 
is low you can ignore it. 
 
 

Record VU Bars 

 
The Record VU bars provide a general indication as to the level of the 
incoming audio that is being recorded. If you can not see any VU bars then 
Scoop is recording silence. 
 
 

Record Cart Payer 

 
The Record Cart Player is located above the main Cart Players and there is 
only ever one Record Cart Player in Scoop. 
 
 

Playback Cart Players 

 
The Playback Cart Players are used to play all audio in Scoop except when it 
is played directly in the SmoothEdit window. 
 
You can configure Scoop to have between one and six Cart Players, although 
it is recommended that all workstations are configured to have at least two 
Cart Players. 
 
 

Cart Player 

 
This number indicates the number of the Cart Player (e.g. 1 to 6 etc). 
 
 

Count Up 

 
The Count Up timer counts up from zero as the Cart is played. 
 
 

Title / Progress 
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The Title section displays the Cart number for the Cart that is playing, along 
with as much of the Cart Title as can be fitted on screen. 
 
The progress bar underneath shows the current position of playback of the 
Cart in respect to the overall length. It also shows the ‘Jog’ button which is a 
small slider that you can drag left or right using the mouse to ‘jog’ forwards or 
backwards in the Cart. 
 

 
 
 
This lets you fast forward through a section of the Cart without having to listen 
to it all. 
 
 

Count Down 

 
The Count Down timer shows a count down to zero as the Cart is played. 
 
 

Play / Pause 

 
This button is a dual function button. When a Cart is cued but not playing, it is 
a play button (>) and pressing it will start the Cart playing. Once the Cart is 
playing it changes to a Pause button (||) and pressing it will pause playback at 
the current point in the Cart. In this state, the button returns to a Play state. 
 
 

Recue 

 
The Recue button will recue the Cart back to the beginning ready to be played 
again. 
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Eject Button 

 
The Eject button is used to Eject the Cart from the Cart Player. 
 
 

The Stories Window 
 
The Stories window is the window that opens when you double click on a 
Story on the Stories tab. The Stories window allows you to work on existing 
Stories as well as add new Stories to the system. You can also create web 
versions of Stories and add audio Carts to your Stories using the Stories 
window. 
 
So let’s get started with the general layout. 
 
 

The Stories Window General Layout.  

 
 
The general layout of the Stories window is outlined below. 
 
 

 
 
 
When working with the Stories window, the tabs down the right hand side are 
used to switch the content of the main section of the window between the 
following parts of the Story. 
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· Story – The Title and main body of text that is used as the script when 

reading ‘live’ bulletins. 
· Audio – This is used to attach one or more Carts to the Stories. 
· Internet – The Internet tab is used to create a web version of the Story 

that Scoop can publish to your stations web site. 
· Notes – This is where you add additional Notes to the Story. It also 

incorporates the Story History which shows when a Story has been 
edited and by who. 

· Attach – This allows you to attach other file types to a Story. This file is 
then stored alongside the Story and is available to other users. This 
allows you to add additional documents (like PDF’s etc) to Stories that 
Scoop does not necessarily support. 

 
The other sections of the window remain visible regardless of what right hand 
tab is selected. 
 
 

The Story Tool Bar 

 
The Story Tool Bar offers a range of tools that relate to the management and 
manipulation of Stories.  
 
The Story Tool Bar is outlined below. 
 

 
 
 

Save 

 
This button saves the current Story. It will only be enabled once you have 
made a change of some kind to the Story. 
 
 

Print 

 
This will print the current Story to the Scoop default printer. You can change 
the default print using the Print Setup option on the File menu. 
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Undo 

 
The Undo button will undo your last action with the Story you are working on.  
 
N.B. The Undo is field specific so if you typed in some text in to the main body 
of text, then type some text in the Title field and then go back in to the main 
body field and click on Undo, it will delete the last section of text you typed in 
to the main body section. 
 
The Undo only applies to text and will not undo changes to the Audio tab or 
the Attach tab. 
 
 

Cut 

 
The Cut button will remove the selected text from the Story but will add it to 
the windows clipboard. 
 
 

Copy 

 
This button copies the selected text to the windows clipboard so that you can 
paste it somewhere else. 
 
 

Paste 

 
This copies the contents of the windows clipboard to the highlighted section of 
the Story. 
 
 

Delete 

 
The Delete option will delete the highlighted section of text. 
 
 

Font Size 

 
The Font Size drop down tool allows you to select a different size for the 
selected text. 
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~ 
 
 
To use this tool, highlight the text that you want to change the size of and then 
click on the drop down tool and select the new size for the text. 
 
N.B. Because Scoop text is HTML based, the web standard font size system 
is used in place of the more common font size number. 
 
 

Reset Font 

 
Clicking on this option will return a selected section of text back to the default 
text size for Scoop. 
 
 

Bold 

 
Clicking this option will make the selected text bold. 
 
 

Italic 

 
This option is used to add italic style to the selected text. 
 
 

Underline 

 
This option will underline the selected text. 
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Strike Through 

 
Use this option to add strike through effect to the selected text. 
 
 

Bullet Points 

 
If you click on this option then you can add bullet points to the Story. 
 
 

Insert Hyperlink 

 
This option allows you to add a hyperlink to a selected section of text. This is 
particularly useful when you are working on a web version of a Story. 
 
To use this facility, highlight the section of text you want to use for the link and 
then click on the Hyperlink button. You can then add the intended address for 
the hyperlink as well as the standard to use, using the popup window. 
 

 
 
 
 

Check Spell 

 
This option allows you to check the spelling for a selected section of text. 
 
To use this option, select the section of text you want to check and then click 
on the button. 
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The Stories Tab 

 
The Stories tab is used to view and edit the main body of text for the Story. 
This is the text that is used for the scripts when you are reading bulletins ‘live’ 
on air. 
 
 

 
 

Story Title 

 
The Story Title field is used to display the Story Title. You can edit this by 
typing in the field. 
 
 

Lock Story 

 



 59 

This option locks the Story so that it can not be edited by other Users. Once a 
Story is locked, a padlock icon is displayed in the Story Tab on the Main Tab 
panel to indicate that it is locked to other Users. 
 

 
 
 
If a locked Story is opened then a padlock icon is displayed in the middle of 
the main body of text and the Story can not be edited without unlocking it first. 
 
 

Main Body 

 
The Main Body is the main text part of the Story and can (in most cases) be 
edited as you see fit. 
 
 

The Audio Tab 

 
The Audio Tab allows you to add one or more Audio Carts to your Story. You 
can also review and reorder the Carts attached to a Story as well as open 
them in SmoothEdit for editing the audio or Cart Details. 
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Adding A Cart To A Story 

 
To add a Cart to a Story, locate Cart that you want to add using the Audio 
Browser and then drag it on to the Audio tab on the Story window. 
 

 
 
You can also change the order of the Carts attached to the Story by dragging 
the Carts up or down the list. 
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Playing And Editing And Removing Carts From Stories 

 
You can review a Cart listed in the Audio tab by clicking on the Play button on 
the Cart itself. 
 

 
 
 
You can open the Cart in SmoothEdit to allow you to edit the audio or Cart 
Details by clicking on the Edit Cart button. 
 

 
 
You can remove the Cart from the list by clicking on the Remove button. 
 

 
 
 
You can also add the Carts listed in to the Cart Pad by clicking on the Pad 
button. 
 

 
 
 

The Internet Tab 

 
The Internet Tab is used to create an alternative web version of the Story. 
This will then be used by Scoop when it publishes the Story to your stations 
web site as part of a bulletin. 
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When you first visit this tab, all of the fields will be blank. This is so that you 
can create a totally new version of the Story for the web site. If you wish to 
use the standard Story text as a basis for the web version, you can copy the 
text using the Copy buttons on the Web Title and Web Body fields. 
 

 
 
 
You can also add in a Sub Title if you wish. 
 
The Web Body Short Summary field is used to provide a short summary of the 
Story. This is used by Scoop when it generates the News Headline page 
which features bulletin Story Titles and a short summary along with a link to 
the full Story. 
 
The Short Summary should be just a few lines that puts across the premise of 
the Story. You can use the Copy Paragraph button to select a single 
paragraph to use as the Short Summary. 
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To use this feature, click on the Copy Paragraph button and select the 
paragraph you want to copy from the menu that pops out. 
 
 

The Notes Tab 

 
The Notes tab provides access to additional Notes for the Story as well as a 
history of when the Story has been edited and who was logged in at the time. 
 
 

The Attach Tab 

 
The Attach tab shows a list of all the files that are attached to a Story. The 
attached files are presented as a list and if the file is in a format that Scoop 
can handle then you will also see a preview of the file. If the File is in a format 
that Scoop does not recognise, you will see a link to the file. If you click on 
that link then the file will be opened using the default windows application for 
files of that type. 
 
 

The General Tab 

 
The General tab is used to set general information about the Story and a 
summary of the primary Cart attached to the Story. The General tab is useful 
as it allows you to add and review a single Cart attached to a Story without 



 64 

having to switch to the Audio tab and as most Stories only have one audio 
Cart, it can save time. 
 
 

The General Tab Layout 

 
The General tab layout is outlined below. 
 

 
 
 

Primary Cart Number 

 
 
This field shows the Cart number for the first Cart listed on the Audio tab on 
the Stories window. You can also type in a Cart number in to here as an 
alternative to dragging a Cart from the A Browser to the Audio tab on a Story. 
 
 

Cut Number 

 
The Cut Number is a reference for the audio cut that is often supplied by the 
‘wire feed’ service. 
 
 

Out Cue 

 
The Out Cue is usually used to indicate the last word spoken in an audio Cart, 
and this in turn acts for a cue to the journalist when they are using the audio 
Cart in a live bulletin. This information is often provided as part of a ‘wire feed’ 
service. 
 
 

Browse 
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This button opens the Audio Browser which allows you to browse the Audio 
Wall and select a Cart to attach to the Story. 
 
 

Estimated Read Time 

 
This is an estimate made by Scoop as to how long the text for the Story will 
take to read.  
 
 

Cart Length 

 
This shows a total length of all the audio Carts that are attached to the Story. 
 
 

Overall Length 

 
This adds the Estimated Read Time to the Cart Length to give you an overall 
estimated length for the Story. 
 
 

Play Cart 

 
This will play the Primary Cart using one of the Cart Players. 
 
 

Edit Cart 

 
This will open the Primary Cart in to SmoothEdit allowing you to edit both the 
audio and Cart Details. 
 
 

Review End 

 
The Review End button will load the Primary Cart in to a Cart Player and play 
the last few seconds of the Cart to allow you to review how the Cart will end. 
 
 

Record Button 
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The Record button is used to record in to the Cart number specified in the 
Primary Cart field or if no Cart Number is specified, in to the next free Cart in 
your User Edit Range. 
 
 

The Information Tab 

 
The Information tab is used to view and modify some additional information 
about the Story. 
 

 
 
 

Category 

 
The drop down Category list allows you to alter the Category that a Story is in. 
 
 

Author 

 
The Author field allows you to alter the authors name for the Story. 
 
 

Priority 

 
The Priority drop down list allows you to alter the priority applied to the Story. 
 
 

The Other Tab 

 
The Other tab provides some summary information about the Story. 
 

 
 
 
 

The SmoothEdit Window (Edit Cart) 
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The SmoothEdit screen (also sometime called the Edit Cart) is used to view 
and edit the details and setting for Carts and also edit the actual audio should 
you wish to.  
 
A good working knowledge of SmoothEdit is essential for getting the most 
from your system but as the SmoothEdit screen plays a big role in adding 
Carts to your system, you are likely to be familiar with it fairly quickly. The 
picture below shows the standard SmoothEdit screen layout. 
 

 
 
N.B. This screen shot is taken from the SmoothEdit running in Myriad but the 
layout is the same in Scoop 
 

Edit Cart Tool Bar  

 
The Edit Cart Tool Bar offers a range of tools designed to help you when 
working with Carts in general. The Edit Cart Tool Bar differs from the 
SmoothEdit Tool Bar (see below) in that the Edit Cart tool Bar tends to deal 
with the Carts as a whole (text, audio, pictures etc) as opposed to the 
SmoothEdit Tool Bar which concentrates on offering audio editing tools. 
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Cart Number 

 
The Cart Number box shows the Cart Number of the Cart that you are 
currently working on. 
 

External Audio Editor 

 
Whilst Scoop Edit does offer the ability to edit the audio in Carts due to having 
P Squared’s SmoothEdit audio editor built in, but there may be times when 
you need a more powerful audio editor or you would prefer to work with an 
audio editor that you are familiar with. In these circumstances, Scoop can be 
configured to launch a 3rd party external audio editor by clicking on the 
External Audio Editor button. 
 

Link To Wave File 

 
There are two ways that Scoop can deal with the audio that is associated with 
a Cart. The audio file can either be imported in to Scoop in which case a copy 
of the original audio file is made and stored in the Audio Wall Location. The 
alternative way is to Link to the original audio file which does not duplicate the 
file and Scoop uses a reference to that file instead. This method is potentially 
more efficient in terms of hard drive resources but does offer more potential 
for problems, in that the Audio Wall is not centrally located and it is easy to 
delete a file that is linked to without realising it.  
 
The Link To Wave File option has a drop down menu. 
 

 
 
The options are: 
 

· Select the file to link to. 
· Stop linking to the current file. 

 

Export Cart Info 

 
The Export Cart Info option on the Edit Cart Tool Bar allows you to export the 
Cart that you are working on as either a Transport File or an Audio File. 
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If you select Transport File then all of the Cart details will be added to a ‘.zip’ 
file in such a way that other Scoop systems will be able to import them. 
Transport Files contain all information about Carts including copyright details, 
notes, timing information and pictures. 
 
If you select Audio File then the Cart will be exported as a ‘.wav’ file which can 
be used by most software systems. When Scoop creates an audio file, it also 
embeds some key information about the Cart in to the ‘header’ of the actual 
audio file using a convention called Cart Chunk. This means that key 
information such as description lines, and timing information will be retained 
and can be extracted by other Cart Chunk compliant software (and other 
Scoop systems) but some information such as pictures, notes and copyright 
information will be lost. 
 
In both cases, once you have selected the format, all you have to do is set the 
name and location that you want the Cart to be exported to. 
 

 
 

Save Cart 

 
The Save Cart option is only enabled once you have altered the audio or data 
for the Cart you are working on. You can click on the Save Cart button any 
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time to save the changes to the Cart you are working on. If you attempt to 
close a Cart (that you have altered) without saving, you will be prompted to do 
so. You can then decide whether to save your changes or not bother and 
discard the changes you have made. 
 

Delete Cart 

 
The Delete Cart button will delete all audio and data from the Cart Slot you 
are working on, leaving it blank. 
 
If you click on the Delete Cart button, you will be asked to confirm your 
actions before the Cart is deleted.  
 
Caution: Once a Cart is deleted, it can not be recovered so please be careful. 
 

Import Audio File 

 
This option allows you to import either an audio (wav) file or a transport (zip) 
file in to the Cart you are working on. You can either start with a blank Cart or 
a populated Cart depending on whether you want the imported audio to be a 
new Cart or replace an existing Cart on the system.  
 
When you click on the Import Cart option, you will first be warned that 
importing over an existing Cart will erase all previous data. Once you have 
confirmed this, simply use the explorer windows that opens to locate the audio 
(wav) or Transport (zip) file that you want to import. 
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Toggle Cart Description 

 
The Toggle Cart Description option allows you to toggle the Cart Description 
information area between visible and hidden. This is useful if you are working 
on audio editing and want the edit window to be larger. The two screen shots 
below show Edit Cart in both states. 
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The General Tab  

 
The General Tab is used to set the most general information about the Cart 
you are working on such as the Title and Artists, the End Type and the colour 
of the Cart as it appears on the Audio Wall. Crucially, the General Tab also 
includes the Timing Info Panel which includes all the Timing information such 
as Intro and Extro points as well as information about hardware points, Hooks 
and Loops. 
 

Title, Artist & Description Lines 

 
These are used to add the primary description that is displayed on the Audio 
Wall and all places in Scoop where the Cart is used.  
 
In general, the first description line is used for Title whilst the second and third 
are used for Artists and Description. 
 
This can be important as there are areas in Scoop where only the first 
Description line is displayed and more importantly, if you are using AutoTrack 
or AutoTrack Pro, the first Description line is typically imported as Title whilst 
the second and third are imported as Artists one and two. 
 
When you are adding the descriptions for Carts that are not Songs, you can 
use the Description lines in which ever way suits your needs best. 
 
You do not have to use all description lines although it is a good idea to fill in 
at least one on each Cart. Each description line is limited to 50 characters. 
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End Type 

 
This option allows you to select the type of ending that best describes the Cart 
you are working on. There are five options: 
§ Ends (E) – The Cart comes to an abrupt end. 
§ Fades (F) – The Cart fades out at the end. 
§ Sustain (S) – The Cart’s ending is sustained for a period at the end. 
§ Slow Fade (SF) – The Cart fades out over a longer period at the end. 
§ Not Specific (blank) – The ending has not been specified. 

 

Custom Colours 

 
The Custom Colours section allows you to set a specific colour for the 
background and text for Cart as it appears on the Audio Wall. Tick this option 
to enable it, then click on the following buttons: 
 

  
 
To change the background colour of the Cart. 
 

 
 
To change the text colour for the Cart. 
 
In either case, select the colour you want to use with the colour pallet window. 
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Time Info Panel 

 
The Time Info Panel is an essential part of the Cart information as it contains 
the Timing information that Scoop will use when playing Carts. It also includes 
additional information about Looping Carts and also Hardware Events that 
can be associated with certain Timing events. 
 

The Timing Tab 

 
The Timing tab contains the main Timing information for the Cart you are 
working on. 
 

 
 
The key Timing events are: 
 

· Intro Start – The beginning of the Intro (bit you can talk over). This is 
usually set to zero (beginning of the song) unless the song has a 
specific start that you do not want presenters or sweepers to clash 
with. 

· Intro End – This is normally defined as the place in the song where 
you would want your DJ’s to stop talking or your sweepers to finish 
playing. Typically it is when the vocals start or maybe a drum beat 
kicks in. 

· Extro – This is the point that Scoop will start the next item when it is 
performing an automated segue. It is typically very close to the end of 
the song, maybe as it is fading out. 

· Hook Start – The Hook is the most recognisable part of the Song and 
is often used as a ‘teaser’ for what is going to be played soon. Scoop 
has the ability to play Hooks as part of an automated run so this is a 
useful addition to the Cart. The Hook start marks the beginning of the 
Hook. 

· Hook End – This marks the end of the Hook. 
 
If you click on the play button on SmoothEdit (see Smooth Edit Audio 
Controls) you can then click on the ‘Set’ button at the appropriate time to set 
each of the Timing events. You can fast forward and rewind using ‘<’ and ‘>’ 
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keys on the key board or by clicking in the Audio Editing Area. Finally, you 
can adjust the Timing events by using the Audio Editing Area. 
 

The Looping Tab 

 
Scoop also allows you to mark a section of a Cart to be looped when it is 
played. This is most commonly used to create dynamic ‘music beds’ and is 
covered in greater detail in Chapter 2 but in brief, you can mark a section to 
be looped using the Loop tab. When Scoop plays this Cart, it will repeat the 
looped section for either a set amount of iterations or until the presenter 
presses the Play button on the Cart Player that is playing the Cart.  
 
The Looping information and settings are set on the Loop tab. 
 

 
 
The Loop start and end times can be either typed in or set using the Set 
buttons during playback (see Timing tab). Once they have been set, it is worth 
reviewing the Loop using the Play button and if necessary, fine tuning the 
Loop start and end using the Edit Audio Area. 
 
Once you have set the start and end, decide how many times you want the 
loop to happen (e.g. 10 times) and finally whether you want playback to jump 
to the Loop End point when a User clicks the Play button on the Cart Player 
(tick option) or whether you would prefer for the Cart to continue normally 
from the point that the Play button is ticked (leave option unticked). 
 

The Hardware Tab 

 
The Hardware tab allows you to add special Hardware Events to the Timing 
Events described earlier (in the Timing tab section). 
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For each of the Timing events, you can use the drop down list to select a 
Hardware Line that you want to perform an action on, and then use the 
second drop down list to select the action that you want to take. The options 
are: 
 

· Set – Turn on. 
· Clear – Turn off. 
· Flash – Flash on and off continuously. 
· Pulse – Turn on for a short time, then turn off. 

 
 
The most common use for attaching hardware events to timing events, is to 
use a single Cart to control the automated switching of external events such 
as a satellite news service.  
 

The Notes Tab 

 
The Notes tab allows you to add a range of additional notes to the Cart. 
Switching to the Notes tab shows the additional notes that you can add. 
 

 
 
The notes fields on the Notes tab are outlined below. 
 

· Studio Notes for the presenter – As the title suggests, these are 
notes that will displayed on the Log screen when the Cart is played and 
are intended to aid the presenter. 

· DAB Notes to be transmitted to compatible DAB transmitters – 
These notes can be used by OCP (see The Standard Scoop Suite 
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earlier in this Chapter) to feed DAB transmitters with text information 
about the Cart being played. 

· Information displayed on the web – Again, these notes can be used 
by OCP to update your web site in real time, with information about the 
Cart that is playing or playing next. 

· Artist / Performer webpage – This can be used by OCP but also may 
be useful for the presenter. 

· Online store reference – This can be used to add unique ID’s to Carts 
to allow you to link them to external music stores (such as 
www.amazon.co.uk). 

 
The above is intended as a guide only. The Notes fields can be very personal 
to each station so use them in a way that is most appropriate to you. 
 

The Copyright Tab  

 
The Copyright tab is used to add copyright details to the Cart you are working 
on. This in turn, can be used by Scoop to generate accurate reports for the 
copyright agencies in your country (PRS/PPL/MCPS in the UK). 
 
Each country has slightly different definitions for the fields that need to be 
included in the reports submitted to them by radio stations, so it may be that 
some of the fields listed below are not relevant to your situation. 
 

 
 

· Product Title - The title of the Cart you are working on. Clicking on the 
Copy button will copy the Title of the Cart from the General tab. 

· Music Title – The title of any music that are used in the Cart (like 
music used in a promo). Clicking on the Copy button will copy the Title 
of the Cart from the General tab. 

· Recording Number – The unique reference for the original recording 
that you are using. These can usually be found on the spine of 
commercial CD’s etc. 

· Composer/Arr – The names of the composer or arranger if known. 
· Performer – The name of the artist performing the music. Clicking on 

the Copy button will copy the Artist from the General tab. 
· Publisher – The name of the company who published the music used. 
· Record Label – The name of the record label promoting the music. 
· Rights Manage Reference – The rights manage reference if known. 

http://www.amazon.co.uk/
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· Copyright Code – This drop down option allows you to select the 
copyright code that best describes the Cart you are working on. 

 

 
 

· Total Duration – This allows you to set the total length of the Cart. 
Clicking on the Copy button will copy the total length of the Cart from 
the General tab. 

· Music Duration – This option allows you to set the total duration of 
music used in the Cart. This is useful if you have a promo that is made 
up of speech and music as you can exclude the speech duration when 
calculating the copyright reports. 

 

The Other Tab  

 
The Other tab is used to add and display pictures that have been associated 
with Carts, and also to show the last five times the Cart has been played to 
provide an instant recent history for the Cart. 
 

 
 

Pictures 

 
The left side of the Other tab is dedicated to adding and viewing pictures that 
have been associated to Carts.  
 
Why would you do this?  
 
The answer is that OCP (see Myriad) can be used to do a variety of things, 
one of which is update your stations web site, in real time, with information 
about the Carts that are playing and Carts that will be playing soon. This 
information includes text, hyperlinks, online store references (click to buy this 
track etc) and of course pictures. So this means that you have to have a way 
to attach pictures to the Carts. 
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You can add new pictures to the Carts by clicking on the ‘+’ button. You can 
remove pictures from the Cart by clicking the ‘X’ button. 
 
The ‘<<’ and ‘>>’ buttons are used for changing the order that the pictures are 
arranged in on the Cart. Pressing the ‘<<’ or ‘>>’ buttons will move the visible 
picture in the selected direction in relation to the other pictures associated 
with the Cart. 
 
The ‘<’ and ‘>’ buttons allows you to scroll through the available pictures 
attached to the Carts. 
 
Pictures associated with Carts in Scoop must be in the JPEG (jpg) format. 
 

Last 5 Plays 

 
The rest of the Others tab shows a brief history of the Cart including the date 
and time of the last five times that Cart was played. It also shows the Scoop 
workstation name of the PC that played them. 
 
You can clear this recent history by clicking on the Erase This Last Play 
Information button which, will clear this history but will not affect the overall 
play logs that Scoop keeps so it will not impact on your copyright reports or 
scheduling system reconciliation. 
 
 

Smooth Edit Tool Bar  

 
The SmoothEdit Tool bar offers a range of tools that you can use when 
working with audio in the Audio Edit Area. 
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These are covered in more detail in the SmoothEdit manual which is available 
from the www.psquared.net web site. 
 

VU Bars  

 
The VU Bars show a graphical representation of the volume of the audio 
being played back in SmoothEdit. It should be regarded as a guide only as the 
VU Bars have not been calibrated. 
 

Time Info  

 
The Time Info panel in the Audio Edit Area shows the overall length of the 
audio being edited. It also shows an estimate of the free disk space left 
available to the Audio Wall. 
 

 
 
 

http://www.psquared.net/
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Extro Marker  

 
The Extro Marker offers a visual representation of the Extro point on the Audio 
Edit Area (see The Timing Tab). The Extro Marker can be repositioned from 
within the Audio Edit Area by moving your mouse cursor to the top of the 
Extro Marker (until the hand icon cursor appears) and then dragging it left or 
right using the left mouse button. 
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Playback Time  

 
The Playback Time panel in the Audio Edit Area displays the time of the 
current play point when audio is playing, or the last placed that you clicked in 
the Audio Edit Area when no audio is playing. 
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Hook Markers  

 
The Hook Markers show a visual representation on the Audio Edit Area, of the 
Hook Start and End points that have been set on the Timing tab (see The 
Timing Tab).  
 
You can move the Hook Start and End points using the Audio Edit Area by 
moving your mouse cursor to the top of either marker until the cursor turns to 
a hand icon (see below). Then use the left mouse button to drag the Hook 
Start or End Marker to the left or right. 
 
N.B. You can play just the Hook by clicking on the Hook button on the Smooth 
Edit Audio Controls. 
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Smooth Edit Audio Controls  

 
The SmoothEdit Audio Controls includes all the controls you need to control 
audio playback in SmoothEdit. The buttons on the Playback Tool Bar not only 
allow you to control the playback of audio, but also to control the way in which 
SmoothEdit deals with playing audio. 
 
 

 
 

Intro Marker  

 
The Intro Marker shows a visual representation of the Intro Start and End 
points as set in the Timing Tab. 
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As with Hooks Markers, you can use the mouse to ‘drag’ these points around 
in the Audio Edit Area by moving the mouse cursor to the top of the Intro 
Marker (start or end) until the cursor changes to a hand icon, then using the 
left mouse button to drag the Intro Markers left or right (see picture in Hook 
Markers section for more detail). 
 

Audio Edit Area  

 
This is the section of the SmoothEdit screen where the audio wave form for 
the audio recorded in to the Cart, is displayed. The wave form represents a 
series of ‘samples’ that are used to describe the audio digitally. This 
information is then used by the Scoop to reproduce the sound perfectly every 
time the Cart is played.  
 
The Audio Edit Area allows you to view the audio wave form and manipulate it 
using the tools provided on the SmoothEdit Tool Bar.  
 
 

 
 
 
Key Timing events (such as Intro, Extro, Loop and Hooks) are also visually 
displayed in the Audio Edit Area. 
 
Audio Editing is covered in much greater detail in the SmoothEdit manual 
which is available to download from the P Squared web site. 
 
 
 

The Bulletin Window 
 
The Bulletin window is used to compile bulletins for ‘on air’ broadcasts and 
publishing to your stations web site. 
 
The Bulletin window actually performs several roles: 
 

· Compile Bulletins – Create bulletins for either live broadcasts or 
publishing to a web site. 
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· Playout Mode – Displays scripts on screen and cues audio Carts to aid 
with live news bulletins. 

· Publish bulletins to your stations web site. 
 
 
Although the Bulletin window performs several roles, it is very easy to use as 
we will see. 
 

 
The Bulletin Window General Layout  

 
The Bulletin Window general layout is outlined below. 
 

 
 
 
These options are explained in more detail below. 
 
 

New Bulletin 

 
This opens a new blank bulletin window. 
 
 

Open Bulletin 

 
This option allows you to open an existing Bulletin window. 
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Click on the Bulletin that you want to open and click Ok. 
 
 

Save Bulletin 

 
Saves the current Bulletin. 
 
 

Save Copy Of Bulletin 

 
Saves the current info as a new Bulletin. To use this feature, click on the 
button and then type in the new Bulletin title. 
 

 
 
 

Live Mode 

 
The Live Mode button is used to switch to ‘live’ mode for reading scripts and 
playing audio as part of a live news bulletin. 
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Web Mode 

 
The Web Mode button is used to switch the Bulletin Window in to Web mode. 
More on this later. 
 
 

Print Bulletin 

 
This button is used to print a hard copy of the active Bulletin. 
 
 

Bulletin Title 

 
The Bulletin Title field is used to add or alter the Title for the Bulletin. This is 
also used if you Open the Bulletin at a later date. 
 
 

Story List 

 
The Story List shows the list of Stories that form the current Bulletin. 
 
You can drag new Stories in to the Story List from the Main Tab area. 
 

 
 
 
You can also drag Stories within the Story List in order to alter the order of the 
Stories in the Bulletin. 
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If you alter the order of the Stories in the Story List, the Script will update 
accordingly. 
 
 

Estimated Bulletin Length 

 
This field displays the estimated overall length of the bulletin including all of 
the audio Carts and the estimated read speed of the scripts. 
 
 

Clock 

 
It’s a clock! 
 
 

Stop Watch 

 
Clicking on the Stop Watch button will start a count up to allow you to time 
your news bulletin. 
 

 
 
Click on the Stop Watch button again to stop the count up and return to the 
Clock. 
 
 

Previous / Next Story Buttons 
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The Previous / Next Story buttons are used to move back to the previous or 
forward to the next Story in the Bulletin. 
 
 

View Previous / Next Story Buttons 

 
These buttons toggle a view of the previous and next Stories in the Bulletin. 
 

 
 
 
 

Play Cart 

 
The Play Cart button is used to play the next audio Cart in the current Story in 
the Bulletin. 
 
As each Story is loaded, the first Cart is automatically loaded in to a Cart 
Player. If a Story has several Carts attached then as each is played, the next 
is automatically loaded in to the Cart Players. 
 
 

Auto Scroll Script 

 
The Auto Scroll Script button toggles the automatic scrolling of the script in 
the main Story window. 
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Edit Mode 

 
The Edit Mode button changes the Story window to be in edit mode which 
allows you to make alterations to the script. 
 

 
 
 
Once in Edit mode, you can make alterations to the script. As soon as you 
make a change to the script, two buttons appear in the top right hand corner 
of the window. The first is the Reload button and is used to reload the original 
Story losing all of the changes you have just made. The second is the Save 
button and is used to save the changes you have made to the original Story. 
 
If you want to leave the changes you have made but not over write the original 
Story, then simply come out of Edit mode by clicking on the edit button. This 
will leave your version of the Story for the duration of this bulletin but discard 
your changes when the bulletin is closed. 
 
 

Out Cue 

 
The Out Cue displays the Out Cue that has been set for the current Story. 
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Story Carts 

 
This area shows the Carts that are attached to the current Story. 
 

 
 
You can alter the order of the Carts in the list by dragging them left or right. 
 

Story Script 

 
This main script area displays the script for the current Story in the Bulletin. 
 
 

Story Title 

 
The Story Title shows the Title of the current Story in the Bulletin. 
 
 

Web Publish Mode General Layout  

 
If you click on the Web mode button on the Bulletin window, it changes in to 
Web Bulletin mode to allow you to preview what the web version of the 
Bulletin will look like, and actually publish the Bulletin to your stations web 
site. 
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Publish Web Bulletin 

 
Click on this button to publish the Web Bulletin to your stations web site. 
 
 

Refresh Web Bulletins 

 
This button will rebuild the preview of the web bulletin. This will happen 
automatically when you change the order of Stories using the Story List. 
 
 

Stop Publishing Bulletin 

 
Once you have stated publishing the web Bulletin, you can cancel the publish 
process by clicking on this button. 
 
 

Bulletin Preview 

 
This displays a preview of the web Bulletin so you can see how it will look on 
your stations web site. 


